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1. Introduction

The Kamstrup 9EVLP is a Windows application. It is
the user interface for 9EVL heat energy meters.

The Kamstrup 9EVLP executes the following func-
tions for a 9EVL meter:

�Meter data reading.

� Register value reading.

� Parameter programming.

� Calibration.

� Flow measuring test.

� Temperature difference and energy measuring
test.

1.1 Some 9EVLP features

The control bar speeds up the selection of com-
mands. The hint text explains the purpose of each
command.

Figure 1. Control bar and hint text area

A message field displays communication status.

Message boxes contain warnings and other infor-
mation.

The 9EVLP checks each input value and reports de-
tected faults. This minimizes the number of input
faults.

Figure 3. Message box that contains warning

Figure 4. The 11EVLP reports invalid parameters

Figure 2. Message field
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2. System requirements

Hardware and software requirements for the 9EVLP are as follows:

Operating system Processor Memory
Free hard

disk
Serial port Mouse

Windows 3.1, at
least MS DOS v.5.0

386/486 2 MB 2 MB RS232/RS485 Yes

Windows 3.11, at
least MS DOS v.5.0

386/486 3 MB 2 MB RS232/RS485 Yes

Windows 95 Pentium 8 MB 2 MB RS232/RS485 Yes

Windows NT Pentium 16 MB 2 MB RS232/RS485 Yes

Windows 2000 Pentium 16 MB 4 MB RS232/RS485 Yes

It is recommended to enable printing through Windows.
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3. Installation

This instruction applies both to first installations
and version updates.

The Kamstrup Metertool for EVL programs are
supplied on one CD, which also contains the op-
erating manuals of the programs. In addition, you
need an optical serial cable (opto-cable), which
enables the communication between the PC and
the units. You can also use a modem connected to
the PC, which communicates with the unit via tele-
phone network.

3.1 Installation from the Metertool for EVL CD

to the hard disk

To install the programs, place the CD in the
CD-ROM drive of your computer.

If the program does not start automatically, run the
setup.exe program on the CD.

On-screen instructions will then guide the rest of
the installation.

3.2 Windows 2000

In Windows 2000, following selection may be
required:

1. Before you start a Metertool EVL program,
right-click the icon of the program

2. Select Properties

3. Select the tab Shortcut

4. Tick the Run in a Separate Memory Space box

5. Choose OK
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4. Languages

The Kamstrup 9EVLP has three command langua-
ges. The language can be changed when the pro-
gram is running.

Do the following to change the language:

1. Choose the Language... command from the
Settings menu.

2. Choose the desired language.

3. Click the OK button.

That language is now the default language when
the application is run the next time.

Figure 7. Language command

Figure 8. Three languages of the Kamstrup 9EVLP
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5. Online help

Choose the Contents command from the Help
menu to use the Online Help.

Next, select the 9EVLP application from the list:

� 9EVLP

� 10EVLP

� Kamstrup 11EVLP

� 9VP

� EVLS

After this, you can read additional information on
any of the following topics:

Figure 9. Contents command

5.1 Welcome to Kamstrup 9EVLP

Online Help!

� Language settings

� Communications settings

�Modem connection and disconnection

� Reading data from a meter

� Reading instantaneous registers

� Reading peak registers

� Reading cumulative registers

� Flow testing

� Temperature and energy testing

� Programming

� Calibration

The Online help can also be opened by clicking the
Help button in dialog boxes.
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6. Communications settings

Communications settings and modem initialization
parameters are specified using the Communication
command from the Settings menu.

6.1 Communications parameters

There are two ways to communicate with a Kam-
strup 9EVL meter depending on the connection
type.

�Optical/Cable option using the IEC 1107 proto-
col: Communication speed can be chosen bet-
ween 300 bps and 9600 bps depending on the
communication speed programmed to the meter.
Choose Auto as the communication speed. For
example, using the 300 bps option you can force
the meter to 300 bps speed. If the meter has
only 2400 bps speed, the Constant 2400 bps is
the only option available.

�Modem option using the IEC 1107 protocol: The
communication speed can be either 300 bps or
constant 2400 bps. The latter speed is available
only if the Constant 2400 bps parameter of the
meter is in use.
If the IEC 870-5 protocol (M-Bus) is in use, com-
munication speed can be chosen between 300
bps and 9600 bps depending on the communi-
cation speed of the IEC 870-5 protocol program-
med to the meter. However, the speed cannot be
Auto or Constant 2400 bps.

Note!

If the IEC 870-5 protocoll (M-Bus) is in use, the
modem must support 11 bit character length.

� The RS485 port option allows you to choose
RS485 serial port as the communications set-
ting. It is a separate card in the PC.

Specifying communications parameters

1. Choose Communication command from the
Settings menu.

2. Specify the connection type. If you chose the
modem, choose also the modem type in the
Modem menu. If the modem you use is not in
the menu, choose the Default option.

3. Choose the protocol.

4. Choose the communication speed.

5. Choose a serial port COM1 … COM4.

6. Click the OK button.

Hint

If the communication speed of the meter is not
known, choose the Auto option. Then the PC com-
municates at the speed programmed to the meter,
unless the Constant 2400 option has been chosen.

Example

In the following, the communication speed is
changed from 2400 bps to 9600 bps using the
Optical/Cable connection and the IEC 870-5
protocol.

1. Open the Programming dialog box from the
Operations menu.

2. Choose Settings. In the Communications set-
tings dialog box, choose the current communi-
cation speed 2400 bps (see Hint above).
Click the OK button.

3. Type the meter password in the Password field.
Click the Read button to read the meter pro-
gramming parameters.

4. After successful reading, check the Communi-
cation checkbox. Click the Edit button to open
the Communication dialog box.

5. Choose 9600 bps as the IEC 1107 protocol
speed. Click the OK button.

6. Click the Write button.

7. After successful writing, open the Communica-
tions settings dialog box. Choose 9600 bps as
the communication speed. Click the OK button.

6.2 Modem commands

The modem commands have two parameters:

�Modem type: Choose the modem you use.

� Call timeout: Specify the time that the modem
waits for a response. Default call timeout is 60
seconds.

Note!

The modem commands can be modified also by
using a text editor program. Open the MODEMS.INI
file in the ENETOOLS directory, and make the re-
quired changes.

Figure 10. Communication command

Figure 11. Communications settings dialog box
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7. Modem connection and disconnection

In remote reading, a connection between two mo-
dems is made using the telephone network. When
the meter connection is no longer required, it can
be terminated. Then the telephone line is free for
other use.

7.1 Connection

If the connection type in Communications settings
is Modem, the Kamstrup 9EVLP activates Connect
command from the Modem menu.

7.2 Establishing connection between modems

1. Choose Modem as the connection type in the
Communications settings dialog box. It activa-
tes the Connect command from the Modem
menu.

2. Choose Connect from the Modem menu.

3. Type the remote telephone number in the Dial
field or choose the number from the Telephone
catalogue.

4. Click the Dial button. Wait until the Kamstrup
9EVLP has established the connection. If the
connection is established, the Kamstrup 9EVLP
closes the Dial-up dialog box automatically.

7.3 Saving telephone numbers in

Kamstrup 9EVLP Telephone catalogue

1. Choose New entry.

2. Type name and number to the proper fields.

3. Click the Save button.

7.4 Disconnection

When you no longer need to communicate with the
meter, terminate the connection by choosing the
Disconnection command. Wait for a few seconds.
After disconnecting, the Kamstrup 9EVLP activates
the Connection command and disables the Discon-
nection command.

Figure 12. Dial-up dialog box
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8. Reading data

The data from the meter can be read by choosing
the Reading command from the Operations menu.

The data can be copied to other Windows applica-
tions or saved in text format using the Reading
data dialog box. Then the file can later be used in
most text editor programs or even in Microsoft
Excel.

Reading data from Kamstrup 9EVL meter

1. Choose Reading from the Operations menu.

2. Choose the type of meter that is read.

3. Type the device address, if necessary.

4. Choose the reading mode:
- Data readout
- History data (10EVL)
- Extended data readout
- Tariff data readout
- M-Bus reading

5. Click the Read button.

Note!

If the meter’s M-Bus list is read without an IEC
870-5 card, the meter communications protocol
must be specified using the meter’s push buttons.
Choose IEC 870-5 as the protocol for the Kamstrup
9EVLP program. Then set the proper communica-
tion speed. Note that Auto or Constant 2400 bps
options are not available in the M-Bus protocol.

The meter readings are displayed in a separate
WordPad document. They can then be copied to
Windows clipboard and moved to other Windows
applications.

The reading data can be saved in file format using
the commands in the File menu. The recommended
file name extension is “.DAT”. When a file is saved
or opened, the Kamstrup 9EVLP lists all existing
data files.

Figure 13. Data readout in Reading data dialog box



20

5
5

1
2

-1
1

7
G

B
/0

4
.2

0
0

4
/R

e
v.

A
1



21

5
5

1
2

-1
1

7
G

B
/0

4
.2

0
0

4
/R

e
v.

A
1

9. Registers reading

A Kamstrup 9EVL meter has the following kinds of
data registers:

� Instantaneous registers

� Peak registers

� Cumulative registers

The Registers Reading command is used to read or
reset register values.

9.1 Instantaneous registers

Reading of instantaneous registers

1. Choose Registers Reading from the Operations
menu.

2. Choose Instantaneous values from the popup
menu.

3. If you do not want to read all the registers, un-
check the All checkbox. Then select the regi-
sters you want to read.

4. Type the password and, if necessary, the devi-
ce address.

5. Click the Read button.

6. You can copy the values of instantaneous regi-
sters to Windows clipboard by selecting the va-
lues you want to copy from the separate
WordPad document. Choose the Copy com-
mand from the Edit menu. To save the values,
choose the Save as command from the File
menu. Give the file a name with the recommen-
ded file name extension “.DAT”.

Resetting of instantaneous registers

1. Choose Registers Reading from the Operations
menu.

2. Choose Instantaneous values from the popup
menu.

3. Type the password and, if necessary, the devi-
ce address.

4. Click the Reset button.

Note!

The Reset command resets all the registers, not
only the selected ones.

9.2 Peak registers

Reading of peak registers

1. Choose Registers Reading from the Operations
menu.

2. Choose Peak values from the popup menu.

3. If you do not want to read all the registers, un-
check the All checkbox. Then select the regi-
sters you want to read.

4. Type the password and, if necessary, the devi-
ce address.

5. Click the Read button.

6. You can copy the values of peak registers to
Windows clipboard by selecting the values you
want to copy from the separate WordPad docu-
ment. Choose the Copy command from the Edit
menu. To save the values, choose the Save as
command from the File menu. Give the file a
name with the recommended file name exten-
sion “.DAT”.

Resetting of peak registers

1. Choose Registers Reading from the Operations
menu.

2. Choose Peak values from the popup menu.

3. Type the password and, if necessary, the devi-
ce address.

4. Click the Reset button.

Note!

The Reset command resets all the registers, not
only the selected ones.

You need a programmer access level to the Kam-
strup 9EVL meter to reset the peak registers.

Figure 14. Registers reading command

Figure 15. Instantaneous registers dialog box
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9.3 Cumulative registers

Reading of cumulative registers

1. Choose Registers Reading from the Operations
menu.

2. Choose Cumulative values from the popup
menu.

3. If you do not want to read all the registers, un-
check the All checkbox. Then select the regi-
sters you want to read.

4. Type the password and, if necessary, the devi-
ce address.

5. Click the Read button.

6. You can copy the values of cumulative registers
to Windows clipboard by selecting the values
you want to copy from the separate WordPad
document. Choose the Copy command from
the Edit menu. To save the values, choose the
Save as command from the File menu. Give the
file a name with the recommended file name
extension “.DAT”.

Resetting of cumulative registers

1. Choose Registers Reading from the Operations
menu.

2. Choose Cumulative values from the popup
menu.

3. Type the password and, if necessary, the devi-
ce address.

4. Click the Reset button.

Note!

The Reset command resets all the registers, not
only the selected ones.

You need an adjuster access level to the Kamstrup
9EVL meter to reset the peak registers.
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10. Testing

10.1 Temperature difference and

energy measuring test

Temperature and Energy command sets the meter
to two alternative test modes. The testing is done
via serial bus.

Choose Temperature and Energy from the Testing
popup menu of the Operations menu.

Temperature difference and energy

measuring test

1. Choose Temperature and Energy from the
Testing menu.

2. Choose the test mode.

- Manual: In this mode, the user must feed the
volume pulses manually using the test con-
nector. This is done by using the buttons on
the meter. The test register values are cumu-
lative.

- Automatic: In this mode, the 9EVL meter gen-
erates the test pulses automatically. The test
register values are averaged per pulse.

3. Type the password and, if necessary, the devi-
ce address.

4. Click the Connect button to establish the con-
nection to the meter.

5. Click the Start button to start the testing.

6. Click the Stop button to stop the testing.

7. Click the Disconnect button to terminate the
connection to the meter.

Figure 16. Testing command

Note!

When establishing the connection, the meter type
is defined automatically. The meter type determi-
nes the number of decimals in the test registers.

When terminating the connection using the Discon-
nect button, the 9EVLP program asks whether to le-
ave the meter in the test mode or set it back to the
normal mode. Click No in the message box to set
the meter to the normal mode. If the message box
is closed without terminating the connection, the
meter remains in the test mode. If this happens
unintentionally, reopen the testing dialog box,
establish the connection and terminate it using the
Disconnect button.

10.2 Flow measuring test

The Flow command sets the meter to a mode, in
which the flow measuring test can be done via seri-
al bus.

Choose Flow from the Testing popup menu of the
Operations menu.

Flow measuring test

1. Choose Flow from the Testing menu.

2. Type the password and, if necessary, the devi-
ce address.

3. Click the Connect button to establish the con-
nection to the meter.

4. Click the Start button to start the testing.

5. Click the Stop button to stop the testing.

6. The reference tank volume can be given either
as Volume or Mass. When you click the Calcu-
late error button, the program calculates the er-
ror percentage of the test register. The error
percentage can be used directly in calibrating
the meter.

7. Click the Disconnect button or close the dialog
box to terminate the connection to the meter.

Figure 17. Flow command
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11. Programming

The Kamstrup 9EVLP can be used to program all
parameters for the meter.

Choose the Programming command from the
Operations menu.

11.1 Editing parameters or

making a new program

1. Choose Programming from the Operations
menu.

2. Type the password and, if necessary, the devi-
ce address.

3. Choose the program form:

- Basic meter

- Communication

- Tariff

4. Click the proper button (New or Edit) and fill in
the form.

- If you click the New button, the program dis-
plays all the program forms starting with the
Basic meter form. All the forms are empty.

- If you click the Edit button, the program dis-
plays the program form, which was selected
in the Program form section.

Figure 18. Programming command

Figure 19. The program form for Basic meter

- If there is a tariff card attached to the meter,
the tariff card option should be turned on.
If the meter has no tariff card, the option
should be turned off. This prevents sending
unnecessary tariff commands to the meter.

5. Accept the new parameters by clicking the OK
button.

6. If you want to save the parameters to disk, type
a new name to the Program list field. Then click
the Save button.

Hint

You can make a new program more easily if you
choose, in the Program form, the MP 115/240 op-
tion for small pipes and the MP 175/1150/1300
option for large pipes. Then load the factory para-
meters by choosing the Defaults option. After this,
you can modify the parameters by selecting the
program form and clicking the Edit button.

11.2 Loading programming parameters

from 9EVLP.PRG file

1. Choose Programming from the Operations
menu.

2. Choose the program name from the Program
list menu.

3. Click the Open button. The title bar of the pro-
gram form displays the program’s name, date
and time of saving.

11.3 Reading programming parameters

from Kamstrup 9EVL meter

1. Choose Programming from the Operations
menu.

2. Type the password and, if necessary, the devi-
ce address.

3. If there is a tariff card attached to the meter,
the tariff card option should be turned on. If
the meter has no tariff card, the option should
be turned off. This prevents sending unneces-
sary tariff commands to the meter.

4. Click the Read button. Check if all the parame-
ters are read successfully.

After successful reading, the message field dis-
plays “Done!” and the title bar displays “Read from
the meter”.
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11.4 Writing programming parameters

to Kamstrup 9EVL meter

1. Choose Programming from the Operations
menu.

2. Make a new program or load a program from
the Program list menu.

3. If there is a tariff card attached to the meter,
the tariff card option should be turned on. If
the meter has no tariff card, the option should
be turned off. This prevents sending unneces-
sary tariff commands to the meter.

4. Type the password and, if necessary, the devi-
ce address.

5. Click the Write button. Check if all the parame-
ters are written successfully.

Note!

Programming requires a programmer access level
to the meter.

If you feed programming parameters, which have
just been read from the meter, only the modified
parameters are written back to the meter. You can
force the Kamstrup 9EVLP program to write all the
parameters by checking the All commands check-
box.

If you want to reset the peak and cumulative regi-
sters after the programming, check the Reset regi-
sters checkbox.

Important!

When programming the transmitting period and/or
the tariff measuring period of a tariff card meter,
the meter clears all previously collected data. Be-
fore the 9EVLP writes these parameters, it warns
about clearing the collected data and asks if the
user wants to skip the command. The user has the
following three options:

Yes

The programming is completed without clearing
the tariff data.

No

The parameters are programmed and the tariff data
is cleared.

Cancel

The programming is canceled.
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12. Calibration

The Kamstrup 9EVLP is used to calibrate the para-
meters of flow and temperature measuring and
also define the meter type.

Choose the Calibration command from the Opera-
tions menu.

12.1 Reading calibration parameters

from Kamstrup 9EVL meter

1. Choose the Calibration command from the
Operations menu.

2. Type the password and, if necessary, the devi-
ce address.

3. Click the Read button.

Figure 19. Calibration command

12.2 Specifying calibrating parameters

to Kamstrup 9EVL meter

1. Choose the Calibration command from the
Operations menu.

2. Type the calibrating parameters to the proper
fields. Choose the meter type.

- The program automatically inserts the last
error percentage either to q

min
error or q

n

error field, if you check the respective option
in the Error percentage (from testing) check-
box (see the “Flow measuring test” chapter
for information on using the Error percenta-
ge).

- The safest way to specify the calibrating
parameters is first to read the parameters
from the meter and then to modify them, if
necessary.

3. Type the password and, if necessary, the devi-
ce address.

4. Click the Write button.

Note!

Calibrating the Kamstrup 9EVL requires an adjuster
access level to the meter.

All unspecified calibrating parameters are ignored
when writing to the meter.
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13. Troubleshooting

13.1 Communication error messages

Message Can’t make connection

Description The 9EVLP could not
establish a connection
to the meter.

Solution Check the communica-
tion failure message
box. Fix the problem.

Message Communication failed

Description The 9EVLP established a
connection to the meter,
but failed to communi-
cate with it.

Solution Check the communica-
tion failure message
box. Fix the problem.

Message Password missing

Description All register reading, pro-
gramming, testing and
calibrating operations
require the meter pass-
word to access the pro-
gramming level.

Solution Type the meter pass-
word in the Password fi-
eld and retry.

Message Time-out

Description The meter has not re-
sponded within the time
limit.

Solution Check the connecting
cable and other commu-
nications settings.

Message Unknown password

Description The meter rejected an
incorrect password.

Solution - Type the correct pass-
word and retry.

- If this message occurs,
when you are using the
RS485 card and a high
communication speed
(2400 bps-9600 bps),
retry using the 300 bps
speed.

Message BCC error

Description Sent data was invalid
(was not in accordance
with the IEC 1107 proto-
col).

Solution Retry several times.

Message Check sum error

Description Sent data was invalid
(was not in accordance
with the IEC 870-5 proto-
col).

Solution Retry several times.

Message Communication error

Description - The program could not
set communication
parameters.

- The COM port chosen
in the Communications
settings dialog box may
not be available.

Solution - Select another COM
port and retry.

- If the error persists,
close the program and
run it again.

- Check the system seri-
al port by running the
MSD.EXE program
supplied with Windows
3.x. It tells you if your PC
supports the chosen
COM port. The program
is also available on the
Windows 95 Install CD.

Message COM port is not open

Description You tried to close the
COM port or send data
when the COM port was
not open.

Solution Click the OK button and
try again.

Message COM port is already
open

Description The COM port chosen in
the Communications
settings dialog box is
probably used by anot-
her program.

Solution - Choose another COM
port or close the pro-
gram that is using the
port. Retry.

- If this error occurs
when there are no other
communication pro-
grams running, close the
9EVLP and run it again.
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Message Modem connection error

Description An attempt to make a
connection using a mo-
dem has failed.

Solution - Check that the remote
modem is on-line and in
the answering mode.

- Check that the modem
initialization parameters
and the call time-out de-
fined in the Communica-
tions settings dialog box
are in accordance with
the modem settings.

- Check that the telepho-
ne line is connected pro-
perly.

Message Can’t allocate memory to
buffer data

Description The 9EVLP could not al-
locate memory to buffer
incoming data.

Solution Check the PC free me-
mory. If there are too
many programs running,
close them.

Message Can’t write to the mo-
dem

Description The 9EVLP could not
send initialization para-
meters to the modem.

Solution - Check the connecting
cable between the mo-
dem and the PC.

- Check that the chosen
COM port is correct for
the modem.

- Check that the initiali-
zation parameters and
the call timeout defined
in the Communications
settings dialog box are
in accordance with the
modem settings.

Message Can’t read all incoming
data

Description The program failed to re-
ceive all incoming data.

Solution - If there are too many
programs running, close
some of them.

- Make sure that the
connecting cable is not
exposed to a strong
magnetic field.

- Retry with the lowest
communication speed
(300 bps).

Message Data failure xx

Description You have tried to pro-
gram an unspecified
parameter to the pro-
gram.

Solution Check the parameters
and retry.

Message Access denied

Description You have tried to edit a
protected parameter.

Solution - This is a security met-
hod, which protects the
meter from accidental
parameter changes.
Check that you have the
authority to change the
programming/security
access parameters be-
fore changing them.

- A programmer access
level is required for pro-
gramming parameters
and resetting peak regi-
sters.

- An adjuster access le-
vel is required for cali-
brating and resetting cu-
mulative registers.

Message Invalid command

Description - The meter has received
an invalid command
number.

- The program sends
only approved com-
mands. However, inter-
ference during commu-
nication may have chan-
ged the command num-
ber.

Solution Retry using a lower com-
munication speed.

Message Missing unit

Description You have tried to read a
meter, which has no
tariff or temperature
card attached.

Solution When you program a
meter that does not
have a tariff card, un-
check the Tariff card
checkbox in the program
form.
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